
Navigation Tool Bar

If you are uncertain what buttons do what on the navigation bar, simply hold the mouse pointer 
over the button in question and a hint will popup showing what it does. Shortcut keystrokes are:

<Ctrl+A> = Insert
<Ctrl+S> = Save
<Ctrl+D> = Delete (Confirmation is Required)
<Ctrl+Shift+C> = Display Calendar

<PageUp> = Previous Panel
<PageDown> = Next Panel





View Menu Option

You may choose to display the "Search all fields for" and "Dialogs" toolbar by selecting this 
menu option and checking the appropriate option. These settings are remembered even when you 
close the program.





Cool Tool Bar

The toolbars at the top of the program are movable much like Internet explorer. You can change 
the order they appear and wheather they are viewable (see "View" help item for more).





Changing Sort Order

There are six indexes that you may choose from to affect the scrolling of the data when using the 
navigation bar or the Grid View: Grouping Code, First, Last & Company Name, Business & 
Home Country. You may change the sort order by using the "Sort" file menu option, double 
clicking one of the six label names on the Name/Address page and when in the Grid View by 
clicking on one of the six title names at the top of the grid. You can see which sort order you are 
currently on by the color of the label name. If it is blue then that is the sort order that you are 
currently in.





Filtering Contacts

Caution: Filtering contacts does not delete them, it simply hides them until the filtering is 
turned off.

You may actually filter the contacts based of one or more fields in the contact database. When 
the contacts are filtered you will NOT be able to view or edit any of the contacts that do not meet 
the filtering criteria. It will appear as though you have lost contact records but have not. Even the 
number of contacts will show the number of records that actually meet the filtering criteria, not 
the total number of contacts in your database. If you turn the filtering off by removing each filter 
criteria then all the contacts will be redisplayed. By clicking the the sixth button from the right, 
the one that says filter, it will bring up a dialog box with your filtering options. You may then 
begin using which fields you wish to filter on by highlighting it then typing in the text to the 
right that you wish to locate. You may then select additional fields and enter the test for them as 
well. For each field you may choose which search options each should use as far as partial 
search, case sensitive, etc. You may view your selection by pressing the "View Summary" button 
at the bottom. This will show you how it will be filtering and on what fields. Once you are done 
you press the "OK" button. The dialog will disappear and the contact screen will be displayed 
with the flittered contacts showing. If none were found then the database will appear empty the 
number of contacts will show zero (0) otherwise your valid matches will be displayed. You may 
press the filter button again to redefine your filter options or to clear them on by one by pressing 
the clear button next the field value your are searching for on that field. If you wish to remove all 
filters and restore the database then press the "New Search" button at the bottom and press "OK". 
Also, when the database is filtered, printing of contacts, labels, etc. will only print those that 
meet the filtering criteria. 





Record View

View all fields in the record and scroll through the data by clicking on the fifth button from the 
right on the main screen. This will pop up a dialog box that will display all the fields for that 
contact in a vertical order. This will allow you to view more of the fields on the screen at one 
time. You may also scroll through the contacts using the navigation bar at the top of the dialog. 
There is also a bookmark option. If you are on a record you may press the bookmark option. 
Then you may scroll through the data looking at other contacts. When you are done and want to 
return to that record press the go to bookmark button and it will return you to that record.





Search Dataset

You may incrementally search through the contacts by clicking on the "Search Dataset" button, 
fourth button from the right. It will pop up a search dialog box showing you all fields in the 
database. You may only search incrementally by the index fields that are available via dropdown 
combo box at the bottom. After you select a field, simply begin typing in text your are searching 
for and the grid view will continue to move towards the record that begins with what you are 
typing.





Search Specific Field

You may search through the database by any field by clicking on the "Search Dialog" button, 
third button from the right, at the top of the main form. The dialog box that pops up will allow 
you to select which field to search on, weather or not its case sensitive, and if it should match 
anywhere in the field or at the beginning. Once selected type in the text you wish to find click the 
"First" button. If a match is found the search dialog box will close and the matching record will 
be displayed in the fields. If a valid record is found you may press the "Search Dialog" button 
again and press the find next button to find the next value, if any exist. When there are no more 
matched a message box pops up saying that 'No More Matches Found'. 





Search All Fields

To search all fields for each contact for a match to a key word simply type what you are looking 
for in the "Search all fields for" box at the top of the program and press <F3> or <Enter>. To find 
the next occurrence press <F3> or <Enter> again until no more matches are found. You should 
be able to just start typing what you want once the program is displayed on the screen. 





Search All Databases

If you have created multiple contact databases then you may search them all by selecting this 
option from the "File" menu or pressing <Ctrl+F3>. This will automatically search through all 
databases for the text your are searching for. If you check the option to 'Restore original contact 
database' then the database you were in before you selected this option will be reloaded. 





Grid View (Overview)

If you would like to see multiple records at one time and scroll through them searching for your 
record then you may use the "Grid View" button located on the "Dialogs" tool bar.    You may 
choose which fields and the order they appear by using the option "Options|GridView|Define 
Grid View Fields". If you wish to view the notes for a contact, double click on the note cell and it 
will display the notes in a popup window. You may configure the fields now by clicking on the 
"Configure" button at the bottom of the Grid View screen. You may no longer resize the fields in 
the Grid View at this time. Due to a change in the component that I use it will be available in 
later releases…I hope. 





Grid View Search

In the entry box on the Grid View screen simply type in the search string you wish to find and 
press <F3> or <Enter>. Grid View will scroll through the contacts searching all fields for a 
match. When a match is found you may press <F3> or <Enter> again to find the next occurrence 
of the search string. If no more occurrences exist then a message will tell you that no more 
matches were found. 





Default Grid View

This is a right click popup menu item on the system tray icon. If there is a check mark in front of 
this option then when you double click or select the "Open" option the Grid View will popup and 
let you scroll through the records and when you close it down it will minimize back to the system 
tray. If you want it to always open to the main form then select the "Grid View" button then 
uncheck this option. When you uncheck the Default Grid View option on the popup menu the 
main form will automatically open assuming that you are taking that off so that you can enter or 
edit records in the database. When you check that option the main form remain in the state it was 
in. You may configure which fields are displayed in the Grid View as well as the order in which 
they appear. You may do so by selecting the menu option 'Options|Grid View|Define Fields'. This 
will display a screen that shows all the fields in the database and the order that they currently 
appear in. To choose which fields are displayed in the grid, click the check box next to that field. 
A check mark indicates that it will be displayed and no check mark means it will not be 
displayed. To move the fields order simply highlight the field you want to move and press the 
"Move Up" or "Move Down" button. Once you are through with your changes press the "Save" 
button to apply them. You may abort your changes by pressing the "Escape" button.





Export Contacts

To export contacts select an option under the main menu item "File". You may select which 
fields and the order they are in for transferring contacts into other applications or databases and 
creating a backup of your contacts to load back into MiniFone Book. (Important: you must 
export all fields in the default order they appear when entering the export utility to be able to 
import them back into MiniFone Book). 





E-Mail and URL Addresses

If you wish to send e-mail or open your browser with the address listed you simply double click 
the entry you wish. It will then call your default e-mail program or browser or the default e-mail 
program or browser setup up by you off the main menu under the Options item. 





Call Backs

You can schedule up to three call back reminders for each contact that you have entered. You 
simply enter the date, time, and status and press the 'Post Edit' button on the navigation bar to 
update. The valid status codes are: Open, Closed, & Canceled. These are important. The timer 
will only check those call backs that have an 'Open' status code. This is so that when you 
complete a call back you can change the status to "closed" so it will not be checked and you can 
have a record that the call back has been completed. The same goes for the 'Canceled' code. If 
you decide to cancel the call back, simply change the status to 'Canceled' and post the update so 
that you have a record that the call was canceled and not completed. Callback options on the 
callback page let you set the amount of time between checking for call backs (default is 5 
Minutes) and the amount of time before the scheduled call back to warn you. If a call back event 
is detected then a grid view will popup and display a list of all call backs that meet the criteria set 
on the contact with the numbers and contact name listed. If you double click on an item it will 
take you to the main screen with that record showing so that you may update the status code for 
that contact. If you do not change the status code then it will continue to popup the warning box 
for the time interval you have selected. Callback list button on the call back page will call the 
grid view that is used to display the open calls that have reached their scheduled reminder 
date/time. The exception to this is that when you click the 'Open' button at the bottom of the 
screen it will show you all open call backs regardless of the time. If you select the 'Closed' or 
'Canceled' button then it will show you all calls that have that status code. There is also an 'All 
Calls' button which will show all call backs that have any status code associated with that record. 
Also, if you click the header columns for Company, First Name, & Last Name the call back list 
will be reordered by that column. The 'Clear CB's' button will clear all three (3) call back 
fields(Date, Time, & Status) and update the record for you. 





Notes Entry

On the notes page you may type in free form notes, up to 64K worth. After you have entered the 
notes you update the changes by pressing the check mark (Post Edit) on the navigation bar at the 
top of the form. 





Encrypting and Decrypting Notes

You may now type in a password and press the Encrypt button to encrypt sensitive data you 
might have entered. Entering the password and pressing the Decrypt button will decrypt the 
notes. You must first Decrypt notes before you can edit them. If you decrypt notes that were 
previously saved then it will prompt you to encrypt them again when updating record. The 
password is case sensitive and is unique only to that note record for that contact. It is highly 
recommended that you use the same password for all notes but you are not required to. If you 
forget your password there is no way to recover it or decrypt the note so please use this option 
cautiously.





Coping Business Address to Clipboard

Will copy the current contact records address to the clipboard in a mailing address format:

<Company> (Only if Not Blank)
c/o <First Name> <Last Name>
<Address1>
<Address2> (Only if Not Blank)
<Address3> (Only if Not Blank)
<City>, <State> <Zip>





Coping Home Address to Clipboard

Will copy the current contact records address to the clipboard in a mailing address format:

<First Name> <Last Name>
<Address1>
<Address2> (Only if Not Blank)
<Address3> (Only if Not Blank)
<City>, <State> <Zip> 





Coping All Fields to Clipboard
Will copy all fields for current contact record in a line delimited format to the clipboard.





Dialing Phone Numbers

To dial any of the numbers that are listed in the Phone Numbers page simply double click the 
number you wish to dial. The program uses the Windows/NT dialer program if installed. If the 
dialer is located some where other than the default install directory or not in the path you may 
specify the path in the default dialer path option discussed below.





Warn Before Exiting

If you check this option under the main menu item 'Options' or from the right click menu on the 
system tray icon then when you try to close the program down by accident or on purpose it will 
prompt you to confirm.





Open Minimized

If this option is checked, then when the program is first started it will open and minimize to the 
system tray. If it is unchecked then the program will open normal.





Hide State Fields:

This will make the state fields for both the Business and Home address invisible. This option was 
added for some overseas customers who do not use the state field. Simply check this option from 
the "Options" menu off the main screen or from the pop up menu from the system tray icon. 
Checking this item hides the state and unchecking makes it visible. Hiding the state does not 
delete or remove previous information that is saved for that contact.





Load With Windows

If you select this option then it will load when Windows starts up. To turn it off unselect that 
option. The option is under the main menu item "Options" or the right click popup menu item 
"Options" in the system tray. To ensure that this item is removed when uninstalling, be sure to 
turn this option off before removing program.





Specific E-Mail\Browser

The ability to add your own default E-Mail and/or Browser executable that is called when 
clicking the buttons 'Send E-Mail' or 'WWW'. To select this option you may use the main menu 
option or popup menu "Options|Specify E-Mail/Browser". Enter the complete path of the 
executable and then any program parameters that it requires in the edit box below each option. 
Example: For Microsoft Outlook Express:

Program Name : C:\Program Files\Outlook Express\msimn.exe
Parameters : /mailurl:mailto:

** Be sure not to enter any quotes around either the Program Name or parameter strings! **

Not all E-Mail or Browser programs will require additional parameters. If no parameters are 
required then simply leave blank. If you no longer wish to use a specific program simply 
clear/leave the edit boxes blank.





Printing Contacts

From the main menu under the 'File' option you now have the ability to preview the printed list 
or print the list directly. Any notes and/or Call Back into will be at the bottom of each record if 
any exist. The notes will print to the left and the Call Back info will print to the right. If those 
fields are blank then nothing will print. It designed this way to save printing space for those 
records that have no notes or call back info. The option to print by a page range as well as the 
'Selection' option is not available at this time.





Printing Labels

Requires Avery Label # 5160 (3 across 10 down). Select the "Print Labels…" from the main 
"File" menu option. The label option screen appears. You may choose to print Business and 
Home address labels or just one by checking/un-checking the appropriate box. Also, if you select 
business labels you will have the option of printing the contact name at the top of the label. You 
may also select labels based on the grouping code. If you choose not to use the grouping code be 
sure that the box is empty before printing otherwise labels will only be printed if they have the 
grouping displayed attached to them. You may choose where, on the first sheet of labels, the first 
label begins' printing. Select the Column (1 -3) then the Row (1-10) where the first label should 
start. You may also choose font settings for the labels by clicking on the button labeled "Font". 
Choose the Font, Style, Size, and Color. These options will only work if both your computer and 
printer support these settings. When you are ready to print you may press the "Preview" button to 
see how they will appear before printing or "Print" to send them directly to the printer. There is a 
"Label Count:" in the bottom left hand corner that shows how many labels will be printed. 





Grouping Codes

You may now select a group to associate your contact with. You may also sort the contacts by 
this field by choosing the menu option "Sort|by Grouping Code" or double clicking on the label 
"Grouping Code". You may add or edit grouping codes through the menu option "Options|
Grouping Codes|Add/Edit". To add codes simply type the code you want in the edit box (20 
characters max) and press the "Update" button. To edit an existing code simply double click on 
the code in the list box and it will remove it and put it in the edit box for you to change. If you 
want to delete a code simply highlight the code you want to delete by doing a single click and 
then pressing the right click button and selecting the delete option. DO NOT try to delete a code 
by editing the code and erasing it and then pressing update. Update will not save blank records. 
BE AWARE that there is no integrity checking on grouping codes. That is that if you add a code 
then attached it to several records and then remove the code from the list it will not warn you that 
you are removing a code that is currently being used. It won't hurt anything or cause anything to 
stop working, it will just be unavailable to select until you add it again. If your 'GrpCodes.ini' file 
should get deleted or removed you may rebuild the file from existing database records using the 
'Options|Grouping Codes|Rebuild' option. This will erase any existing file and replace it with 
information in the Grouping Code field in each contact record. Remember that any fields that 
might be in the *.ini file but not attached to any contact will not get added into the file.





Dialer Executable Path

From the menu option "Options|Select Dialer Path" you may select were the windows dialer 
executable is stored. If you leave this blank it will still try to find the program in the Windows 
directory (C:\WINDOWS or were windows was installed). You need only use this option if it 
was not stored in the Windows directory or NT directory. Simply located the "Dialer.exe" 
program and close the window. The value will then be stored. 





Selecting\Creating Contact Databases

This option off the 'File' main menu lets you copy the database files to another directory and 
maintain a list of these databases so that you can switch between them easily. To add a database 
to the list, type in a description and select a path and press the 'Add DB' button. To remove a 
database, use the mouse right click button to pull up an options menu to remove, load, or edit and 
existing entry. When you edit an entry it is removed from the list and displayed in the edit boxes 
below. The 'Add DB' button will then read 'Update'. When done editing simply press the 'Update' 
button to add back to the list. You may switch to another database by simply double clicking on 
the one you wish to open. You can copy the needed database files and choose to erase them after 
the copy is complete by selecting a destination directory then checking the option box and 
pressing the 'Copy DB' button.





Restore Default Screen Size

Will restore the form to its original size when the program is first started.





Calendar

Allows you to view a visual calendar. May move backward or forwards through the months and 
year by clicking on the appropriate button just above the calendar. Clicking on the blue date 
display that shows the current date viewed will reset the calendar to the current day. You may 
also press the button labeled "Today". You may select which day of the week the calendar begin 
with by selecting the day from the drop down combo box.





Default Search Panel

You may select which panel appears when a valid search item is found using the "Search all 
fields for" option on the main screen. IF you are on the home panel and you have selected 
business as the default then when a valid match is found the business panel will be displayed.





Configure Bulk E-Mail

Under the main menu options select 'Email|Options' and the main bulk email screen will be 
displayed. There are two pages: the Send and Connection page. You will need to configure the 
Connection page with your SMTP server name and the return e-mail address that will be attached 
to the outgoing messages. You may select to have the program automatically connect when you 
enter the e-mail screen if you are always connected to your provider via a LAN line, etc. If you 
are not always connected then do not select this option. You will first have to connect to your 
provider using the connection software that they provided then enter this page and press the 
'Connect' button. You will not need to discount unless you want to. When you close the email 
screen it will automatically disconnect the bulk email SMTP connection for you. You may also 
choose to have a log record created showing which e-mail addresses the message was sent to by 
slicking checking that option. The file will be overwritten every time you send e-mail. If shows 
the date and time and all addresses that received the message. All these options will only need to 
be keyed once. They are stored. If you uninstall the program and reinstall then you will need to 
enter them again. On the Send page you may choose to select contacts by a particular grouping 
code. If choose not to then leave this field blank and all contacts will receive a copy of the email. 
You may also choose to select which e-mail addresses for each contact will receive a copy. If you 
mark all three check boxes then each contact that does not have blank e-mail address field will 
receive a copy of the message. You may also attach a file(s) to the message. Simply check that 
option then select the file to attach. If you would like to send more than one file hold the <Ctrl> 
key down as you select files. This will allow you to select multiple files to send. After you have 
entered your subject and message simply press the 'Send' button. If you wish to view the log file 
of who received the message press the 'View Log' button which will pull the file up in notepad. 
When done sending your messages press the 'Close' button. The log file will remain until you 
send another message.





Updates List
4.99.0915: Added the first beta release of the ODBC Import/Export Utility.

4.99.0902: Added a new field that allows you to select a future date for a contact that once the 
current date passes the date entered it will automatically delete that contact.

4.99.0625: Converted help to a standard windows help file.    Reduced the amount of system 
resources the program uses when open.

4.99.0617: Many little improvements…enhanced the calendar, changed hot key for displaying 
calendar, etc.

4.99.0520: Set a default search panel display for the "Search all fields for" option on main 
screen.

4.99.0514: Ability to check for updates from the "Help" menu when connected to the Internet. 
Pressing <F1> now pulls the help screen up. Added a calendar which can be viewed by pressing 
<Ctrl+C> or pressing the calendar button to the left. Also, scroll through the buttons at the left by 
using the up and down arrows just below the them.

4.99.0511: Completely redesigned look and user interface. Functionality remains the same with a 
fiew exceptions. The search all fields option is a toolbar that is at the top of the screen, there is 
no longer an icon at the top of the program. To move between each of the different panels click 
on the icon at the left.

4.99.0505: Added ability to export all or selected fields in any order for importing into other 
applications or databases. 

4.99.0407: Corrected a problem that occurred when using a different date setup in Windows 
under the regional settings section. Would give the error that the date was not valid when saving 
a contact record.

4.99.0329: Choose where to begin printing the first label on the first sheet. Also, pressing F3 will 
pop up the Search All dialog box.

4.99.0210: Added additional contact view screens and search capabilities. You may now filter the 
contacts on one or more fields in the database. Also, added the additional address fields for both 
the business and home addresses. Also, you may now put the registration file that is sent upon 
registration in a different directory and point to it to register the program. This option was added 
for companies that wish to install on multiple machines and not have to copy the file to each 
work station or remember the code.

4.99.0111: Program will start with the last sort order and screen position/size when it was closed.

4.98.1215: Changed version number so that the last four numbers represent the Month and Day 
that the new release was completed. The two digit number in the middle will represent the year. 
Added the ability to search when in Grid View. It uses the 'Search All' fields option. Included the 
ability to bulk email your contacts a form email letter. Can select by Grouping Code.

4.98.330: You may now view notes for a contact when in Grid View by double clicking on that 



cell. You my now purchase the software on-line. Open the help screen and select the "Purchase 
Software" option to show you the link to the secure site. You may click the link if you are 
connected to the Internet and it will take you to their site.

4.98.320: Converted help to the Internet Explorer 4 HTML version. Made some general 
enhancements.

4.98.315: Ability to search all databases listed in the additional database list. Move the Call Back 
list menu option to the Call Back page as a button.

4.98.310: Visual enhancements and modified the Call Back listing to show each call back listing 
on a separate line so that when it pops up to notify it only shows the one or more CB's that apply.

4.98.305: Added shortcut keystrokes for record handling and E-Mail and URL printing ahs 
changed to only print when they have info by them to save printing space.

4.98.300: This and all future versions are now Shareware.

4.98.283: Added some additional countries to the dropdown list. Prevent resize of main form 
smaller than default settings.

4.98.282: Ability to resize or maximize the form. Option to restore form to default size.

4.98.280: Added ability to search for a contact by looking at all fields in the database.

4.98.272: Added ability to Encrypt/Decrypt individual note records. Also, the ability to search 
through the help.

4.98.270: Added Country field for Business & Home Address and the ability to sort the database 
on those fields. Ability to create and change between different contact databases. Allows you to 
share a database between multiple users and still maintain a private database.

4.98.262: Grid View fields will remain as you adjust them until you enter and exit the definitions 
screen.

4.98.261: Removed the option to copy all fields in a CSV format to the clipboard and replaced it 
with the option to "File|Export Current Contact to a CSV File".

4.98.260: Added the ability to choose the fields and order they appear in the Grid View screen.

4.98.235: Increased the state field to hold 3 characters to support foreign country state 
abbreviations.





Bug Fixes
4.99.0902: Corrected a problem where if you are attached to an additional database and you wish 
to export your contacts it would always export your default contacts database.

4.99.0617: Corrected problem with MiniFone Book not allowing windows screen saver to go 
into lower power mode.

4.98.320: Fixed problem with call back notification always showing all open calls when it pops 
up with a reminder.

4.98.273: Fixed problem with the BDE not installing properly. Recompiled program using BDE 
4.51 instead of BDE 5.0.

4.98.272: All phone numbers will dial when doubled clicked.

4.98.260: Fixed problem when editing the Grouping Codes were it would give you a "List Index 
out of bounds" error when editing an existing code.

4.98.230: Fixed problem with callback notification. When you had more than one call back set 
and changed the status from 'Open' to 'Closed' or 'Canceled' it would still notify you even though 
the second call back was not suppose to be popping up yet. Was not looking at the status code for 
each individual call back entry. Fixed a problem with the dialer were after making a call it would 
not free the modem to be used by another application until the program was closed and re-
opened. 





Registering Software

This program is Shareware.
Single user license price is $15.00US. (Multi User license discounts are available upon request)
It is fully functional except that you may not export any contacts and you do not have the option 
to NOT erase the contacts when you copy the database files to another location. 

You may register by ordering on-line at the link below or forwarding your payment to:

c/o Gary Cooper
CrashCourse Software, Ltd.
PO Box 54321
Oklahoma City, OK 73154-0321

Please make checks payable to Gary Cooper.

If you choose to mail your payment, be sure to include which product it is for, number of 
licenses, your name, mailing address, and your e-mail address so that I can send you the 
registration code to register the product.





Installing Registration Code

From the "Help" menu option select register if it is not dimmed. If dimmed then software is 
already registered. You may then enter your user name and registration code supplied and press 
the "Register" button. You may also select the location were the registration file supplied was 
copied to and press the "Register" button. If the registration file supplied is copied into the 
installed directory then selecting the location is not necessary. You may simply restart the 
program and it will self register. The Registration File option mainly for larger customers that 
have multiple installs. They can store the registration file in common directory and after 
installing on a new workstation select the file location and press register.





Purchasing On-Line

You may purchase the software on-line through ARO Systems™, a secure on-line credit card 
transaction processor, by going to the following link: . 

Secure On-Line Ordering Form





How to Reach Us

If you like this program or have suggestions, please send comments to: 

coop@crashcoursesoftware.com

You may check for upates to the program from the "Help|Check for update" menu item in the 
program or by going directly to our web site at the link below.

Be sure to visit our web site    to check out lots of cool free utilities and download the demo 
version of what we think is the BEST Windows 95/98 workstation security program that money 
can buy!!!!! 

CrashCourse Software, Ltd. Home Page





Delete Contact After
If you enter a date into this field then when you start MiniFone Book and the current date is 
greater than the date in this field that contact will be deleted.    Use this if you need to setup a 
temporary contact that you will only need for a short period of time and after a certain date 
would like to have that contact removed automatically.    Under the 'Options' menu you may 
select to have it warn you and give you the option to delete the contact or keep it.    It will 
continue to prompt you everytime you start MiniFone until you change the date for that contact 
or remove the date all together.    This field is located on the Call Back screen.





Export Current Contact to a file
Selecting this option will export the current contact you are on to a comma quote seperated file. 
This can be used to pass contacts to other users of the MiniFone Book or to import into other 
applications or databases.    It will prompt you for the file name and the location to save the file.





Import Comma Quote File
(Important: you must export all fields in the default order they appear when entering the 
export utility to be able to import them back into MiniFone Book as a comma quote file).

When importing and contacts records exist, it will prompt you to erase existing contacts before 
continuing. If you select no then it will continue with the import and contacts will NOT be 
erased. All values are separated with a comma and quote: (Ex: "First Name","Last 
Name","Company","....). If you choose to create or modify your export file, it is not 
recommended, but if you do be sure that all fields are separated as shown in the example above.

The Import Order is as follows:

First Name
Last Name
Company
Bus Address1
Bus Address2
Bus City
Bus State
Bus Zip
Home Phone
Business Phone
Fax
Cell/Pager
E-Mail Address
Call Back Date1
Call Back Time1
Call Back Status1
Call Back Date2
Call Back Time2
Call Back Status2
Call Back Date3
Call Back Time3
Call Back Status3
Notes
URL
Created {These Two Fields can not be changed by }
Updated {the User. They are for system use only.}
Group
Home Phone2
Business Phone2
Fax 2
Cell/Pager 2
E-Mail 2
E-Mail 3
Url 2
Url 3
Home Address1



Home Address2
Home City
Home State
Home Zip
Title
Business Country
Home Country
Address3
Home Address3
Remove Date 





ODBC Import/Export Utility (Beta)
This utility may be used to directly move contacts into and out of MiniFone Book into another 
database or datasource.    This is accomplished by directly attaching to the source that you wish 
to import and/or eport data to/from through ODBC drivers.    This feature is one that should be 
used by those individuals that feel they have fairly good knowledge of ODBC drivers and are 
comfortable in coniguring them.    Also, problems you might incurr will most likely be the result 
of the ODBC driver and one that I wont be able to correct since I do not have access to the 
drivers code.    This feature will not be replacing the existing import and export routines but 
merely give the end user more flexibility when maintaing and syncronizing more than one 
contact manger program.    It is still recommended that you export a copy of all contacts using 
the other export routine as a backup procedure.

Destination: This will always represent which ever MiniFone Book you are currently connected 
to throuhg MiniFone Book.    Also, it will display above the fields the record count once a source 
has been selected.

Source:  This will be the database or datasource that you will choose to import into the 
Destination file (MiniFone) or from the Destination into the Source file.    In the list box window 
you will be able to move the fields to line them up with the Destination field that it correspond 
with.    This accomplished by clikcing the mouse button down on the field you wish to move and 
dragging it up or down to line it up with its corresponding field.    You may also remove fields by 
right clicking on the mouse and selecting remove.    If you accidently remove a field(s) that you 
need you may push the Reset button to reload all fields again from the source you selected.

Database Alias:  This is the alias of the ODBC driver that was created by you or the application 
that allows MiniFone to connect to the source database.    This is created and maintained usually 
under the ODBC administrator that should be located off the Star menu under Settings,    then 
under Control Panel.

Database Directory: Some databases such as DBase files don't require and ODBC driver to be 
configured.    If you know were the DBase fiel is located then you may select that directory and a 
list of available files will be displayed under the Table Name combo box.

Table Names: This will display a list of valid tables available to choose from based on what 
database or directory you select from the previous selections.    Once you select a table name the 
fields for this datasource will be displayed in the Source list box.    This might takea few seconds 
and the cursor should change to a hourglass with 'SQL' underneath it.    It will then pad each list 
box with spaces to make sure that they each have the same number of fields.    This is so that you 
will be able to map each feild to it corresponding field name in the other list.

Indexes: This should display a list of indexes that belong to the source file.    This field will only 
be needed if you shoud to export MiniFone into the Source and select the option to Add/Update 
contacts.    It will use that index to try and determine which fields detemine if the record already 
exist.    If it already exist then it will update the contact, and if it does not exist then it will append 
it to the Source file.



Reset:    This will reset the fields in the source file to the order they were originally read in at.

Import: This will actually preform the import of the data between the Destination and Source.

Save: Once you have all the Source fields mapped with their corresponding Destination fields 
and have selected all the options you wish you may save that lay out so that it may be relaoded 
back in when you wish to import/export contacts again.

Load: Allows you to load previously saved layouts back in to revent having to remap the fields 
each time you wish to import/export contacts.

Erase Contacts before import: This will erase all contacts in either the Destination or Source so 
be careful using this option.    Also, this option, depending on the weather the datasource is 
shared or exclusive might not work and will give you an error.    It can not erase the table if 
someone else is accessing it.

Abort import on any error:  Select this option if you wish the import operation to quit upon any 
error encountered.    All valid contacts that were imported before the error was encountered will 
remain and will not be reveresed with this option.
Truncate fields to fit: Selecting this option will force fields that are larger than the Destination to 
be truncated or trimed before moving them.    Ex: State field in MiniFone book is 2 characters 
long.    If the state you are importing in is longer then it will be truncated to fit. (Texas --> Te).    
If you leave this option unchecked then it will skip that record and create it in an error file that 
can be viewed from within the Import/Export utility. A button will appear that lets you view the 
bad records.    Once you are done viewing them you may press the same button to return to the 
Import/Export utility.      If you decide that you want those fields imported you will have to run 
the entire import again with this option checked.

Add/Update contacts:    This option will use MiniFone's index for 'First Name' + 'Last Name' + 
'Company' to try and find a match during the import.    If those three fields mathc then that 
contact will be updated.    If those three fields don't match then it will append that contact record 
to the end.    If you try to export from the Destination to the Source then the index you select will 
be used to try and match the records you are importing.    Please use caution when using this 
option since data could be overwritten.    If the index is not uniqied enough then contacts could 
continue to be overwritten as they are imported.








